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Executive Summary
In this work for the NanoMILE deliverable report entitled “Pre-validated new model system
(terrestrial isopods)” we first revised the existing data on validated test system with isopods
established in a previous EU funded project (NanoValid project). Second, we implemented this
knowledge in the NanoMILE project by testing the SOP: “Feeding and bioaccumulation assay with
isopods” with the nanoparticles (NPs) obtained within NanoMILE. The model terrestrial organism
Porcellio scaber (Isopoda, Crustacea) is described and the strength of the selected model is presented.
Third, we developed a novel maternal transfer model system with isopods, conducting four
experiments with two different NanoMILE NPs. We observed classical toxicological parameters,
survival and feeding activity of females. The silver NPs did not cause any effect upon NP ingestion.
The exposure of females on Ag NPs also did not affect the number of produced juveniles. The
bioaccumulation studies revealed that silver was accumulating in the females and not in the juveniles
after 3 days of feeding experiment with Ag NPs. For the conclusion, the weakness and strength of the
used protocols are discussed and ways of improvement are proposed. We found the assay suitable for
further intralaboratory testing of NanoMILE NPs.
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1. Introduction

Within the Task 6.4 of the NanoMILE project we are investigating maternal transfer and possible
transgenerational effect of nanoparticles (NPs) on juvenile isopods. On the basis of validated feeding
assay with isopod Porcellio scaber and established SOP for bioaccumulation studies in NanoValid
project (Annex 1 and 2) we have developed a new protocol for studying bioaccumulation and effect of
NPs on juvenile isopods developing within females. The additional experiments for pre-validating this
new protocol were done with NanoMILE nanoparticles (Figure 1).

Revision of existing validated feeding assay and bioaccumulation SOPs
for terrestrial isopods:
- data obtained within previous EU projects (NanoVALID)

D 6.8: Pre-validated new model system (terrestrial isopods)
Implementation of the Feeding assay and bioaccumulation SOPs within
the NanoMILE:
- new data with NanoMILE NPs
- maternal transfer studies

Figure 1: The organization of work represented in Deliverable 6.8. The two SOPs for the new model system
were validated within NanoValid project and implementation of these protocols was done in NanoMILE project.
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Single-species toxicity testing is highly important for characterization of chemical impact and only a few
animal species fulfill the criteria for being used as test organisms for testing the effects of pollutants in the
terrestrial environment. The biology of the species must be well known and some of the most important
criteria are organism size (possible to maintain laboratory cultures and perform measurements on whole
body), abundance, simple identification, sublethal responses to chemicals and information that enables
differentiation of measured effects from natural background variability (Drobne, 1997).

Isopods are terrestrial invertebrates which are often a species of choice for toxicity studies. Their
digestive system is the main route for contaminant intake and their accumulation in the body is
attributed largely to dietary exposure (Drobne, 1997). Exposure of isopods (prominently P. scaber) to
contaminant-treated food was established as a standard toxicity testing protocol by Drobne and
Hopkin (Drobne and Hopkin, 1994, 1995) and was later adapted for nanotoxicity testing (Golobič et
al., 2012). The species has been used in a variety of tests on the effects of elevated concentrations of
metals (Drobne and Hopkin, 1994, 1995; Jereb et al., 2003; Zidar et al., 2005), biocides (Staak et al.,
1998; Stanek et al., 2006), veterinary drugs (Kolar et al., 2010), and also nanoparticles (NPs) (Jemec et
al., 2009; Drobne et al., 2008, 2011, 2012). In these tests several sensitive endpoints have been
measured, including biochemical biomarkers, histopathological changes, behavioral response and
physiological measures as well as organism level responses. The selected biomarkers vary in
sensitivity, duration of feeding before the effect is detected and their ecological relevance.
Isopods have been shown to accumulate the highest concentrations of metals such as zinc, cadmium,
lead, and copper so far recorded in any soft tissue (Hames and Hopkin, 1989; Vijver et al., 2004).
Therefore, data on stored amounts of metals gives insight into bioavailable amounts of metals ingested
with food and so the isopods are a useful model in bioaccumulation studies (Hassall et al., 2005).
Metal accumulation in digestive glands, which are the major digestive organ with intestinal, hepatic,
and pancreatic functions, is explained also as a detoxifying mechanism, which diminishes the potential
adverse effect of ingested metal ions (Hames and Hopkin, 1989).

One of the adaptations of these crustaceans on terrestrial environment is the development of the
marsupium, the brood pouch where females are carrying eggs. It is provisioned with fluid from the
mother and allows early development to take place independently of an external water source (Surbida
and Wright, 2001). During embryonic development in the marsupium the eggs are nourished by the
female (Hoese and Janssen, 1989; Warburg and Rosenberg, 1996). They provide nutrition to the
developing mancae (Hoese and Janssen, 1989) and they can also regulate pH and osmolality of the
marsupial fluid (Surbida and Wright, 2001). It has been shown that diet of females can affect
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phenotypic variation of juveniles (Kight, 2009) and that was motivation to study effect of female oral
exposure to NPs for implementation of established model isopod system for testing of NPs.

2 Basic biology of Porcellio scaber (Isopoda, Crustacea)

Isopods inhabit the upper layer of the soil and surface leaf litter in a variety of urban and natural
habitats. They belong to both meso- and macrofauna with an average body length between 8 and 12 mm.
Some representative of the species can grow up to 20 mm long and usually have a grey colour, paler
underneath, although brown, yellow or orange hues may also be observed (Figure 2).

Figure 2: A population of Porcellio scaber (Isopoda, Crustacea) in the natural habitat (photo: A. Jemec).

Their body is equipped with a number of types of appendages, like antennae, mouthparts, thoracopods,
pleopods, and uropods. These provide a large surface area, and as such they lose water rapidly
(Kostanjsek et al., 2006). They feed mainly on dead organic material, are distributed throughout the
world, and are abundant in many different terrestrial environments (Van Capelleveen, 1987). They also
play an important role in decomposition processes, mainly as fragmentors of dead plant material. Their
choice of food depends largely on the quality of the leaves, the stage of decomposition and the
moisture level. Isopods also eat their own feces and those from other soil animals so they are often
regarded to be coprophagous (Kostanjsek et al., 2006). The body of terrestrial isopods is covered by a
cuticle. Frequent moulting is an important characteristic of both juvenile and adult isopods and is
related to growth, renewal of the cuticle and reproduction in mature females. Isopods moult in two
phases, first shedding the posterior and then the anterior half of the body.
5

The food consumption of terrestrial isopods varies according to species (Warburg, 1987) and is
approximately 0.4 mg dry food per mg dry wt. of animal per day (own observ.). Food assimilation
efficiency is between 30 and 50% in P. scaber (Nair et al., 1994; Drobne and Hopkin, 1995). Food can
remain in the gut for 4−17 h (Hartenstein, 1964) and is digested and absorbed in a 24 h digestive cycle
(Hames and Hopkin, 1989). When the feeding rate is lower, food remains in the gut for a longer time.
Animals produce 10−35 faecal pellets per day and one pellet is about 1. 5 ± 0.2 mm long. About five
to seven pellets fill the entire gut. Daily faecal production is independent of the animal’s size (own
observation, Kostanjsek et al., 2006).
The digestive system of the terrestrial isopod P. scaber is composed of a stomach, four blind-ending
digestive gland tubes (hepatopancreas), and a gut (Figure 3). Food enters the digestive glands directly
via a short stomach or after the reflux from the gut, and ingested material is mixed with digestive
fluids. The cuticles of the foregut and hindgut are completely renewed during exuviation (Štrus and
Blejec, 2001). The pH in the digestive system varies from acidic in the midgut glands and anterior
chamber of the hindgut to slightly acidic in the posterior part (Zimmer, 2002).

Figure 3: Anatomy of the digestive system of Porcellio scaber. a Dorsal view of stomach (S), midgut glands
(MG) and hindgut consisting of anterior chamber (AC) with typhlosole (T), papillate region (P) and rectum (R)
(photo: Kostanjšek et al., 2006; Jemec A.).

Hepatopancreatic tissue has intestinal, hepatic and pancreatic functions and is directly exposed to
substances in the food (Zimmer, 2002).The hepatopancreatic epithelium contains two cell types, the
large secretory and absorptive B cells that project into the lumen of the hepatopancreas and the wedge6

shaped S cells that lie between the B cells and accumulate large amounts of ions such as calcium, and
salts of uric acid (Wägele, 1992). A link between the physiological condition of isopods and the
histological appearance of the hepatopancreas and the biochemical stress markers has been confirmed
(Jemec et al., 2012).

After fertilization of female isopods, the egg is moved to the brood pouch (marsupium). The terrestrial
marsupium is filled with fluid from the mother and this allows early development to take place
independently of an external water source (Surbida and Wright, 2001). In the marsupium embryo is
developing and this yellowish developing egg is visible through the brood pouch (Figure 4). During
embryonic development in the marsupium the eggs are nourished by the female through cotyledons
(Hoese and Janssen, 1989; Warburg and Rosenberg, 1996).

Figure 4: brood pouch (marsupium) on the ventral side of P. scaber where juveniles are developing. On right
photography the developed juveniles are hatching from the marsupium.
(photo:http://www.botanikbochum.de/pflanzenbilder_tiere/jpg/Porcellio_scaber_Kellerassel_BORobertMueser070609_ja02.jpg)

Intramarsupial development of P. scaber lasts about 35 days under laboratory conditions and includes
embryonic development, from fertilized egg to the early-stage embryo, the mid-stage embryo and the
late-stage embryo, and development of the marsupial larva manca until release to the external
environment (Milatovic et al., 2010). Females provide nutrition to the developing mancae (Hoese and
Janssen, 1989; Warburg and Rosenberg, 1996) and they can also regulate pH and osmolality of the
marsupial fluid (Surbida and Wright, 2001). Diet of females can affect phenotypic variation of
juveniles (Kight, 2009). Donker et al. (1993) showed that females collected from a lead contaminated
area start to reproduce earlier which resulted in a fewer young per female.

Terrestrial isopods are among the most promising organisms in terrestrial ecotoxicology and Porcellio
scaber is one of the widely studied terrestrial isopods. Therefore P.scaber is already proposed as the
organism of choice for testing the toxicity of metals in the terrestrial environment (Drobne and
7

Hopkin, 1995). The advantage of using terrestrial isopods in toxicity studies compared to other
terrestrial organisms is that a battery of parameters (e.g. organism feeding activity, digestive cells
histopathology changes, biochemical parameters…) can be tested at different levels of biological
complexity. Organisms have acquired different feeding strategies, which allow them to respond to
spatial and temporal variations in the quality and quantity of food (Zimmer, 2002).

3 In vivo feeding exposure of isopods (Porcellio scaber, Isopoda, Crustacea) to NPs
Feeding exposure is the most important means for in vivo exposure of P. scaber to nanoparticles;
moreover, it enables assessment of the exact exposure dose (Drobne, 1997), which is harder to
estimate with other terrestrial invertebrates (e.g. earthworms, collembolans). Any changes in feeding
rates of terrestrial isopods affect the decomposition process and subsequently matter and energy flux
through ecosystems (Drobne, 1997). Feeding exposure represents the normalizing factor for all other
measurements on P. scaber tissues, as established in standard toxicity testing protocol (Drobne and
Hopkin 1994, 1995), and adapted for nanotoxicity testing (Golobič et al., 2012).
The isopod test with Porcellio scaber was first developed by (Drobne and Hopkin, 1994) and later
adapted for exposure to NPs in our laboratory (Golobič et al., 2012, Pipan-Tkalec et al., 2010). In the
test, the animals are fed with NP-contaminated leaves over a period of 14 days (Annex 1: SOP In vivo
feeding exposure of isopods (Porcellio scaber, Isopoda, Crustacea) to nanomaterials, established in
the NanoValid project).
A well characterised suspension of nanoparticles (in distilled water) with known concentration is
applied on abaxial uncontaminated dry hazelnut (Corylus avellana) leaves surface. Leaves are
weighting approximately 100 mg. In the control group, the leaves are treated only with distilled
water. Each individual animal is then placed in a 9-cm Petri dish. One hazelnut leaf treated with
distilled water or NPs suspension placed in each Petri dish is the animal’s only food source. Humidity in
the Petri dish is maintained by spraying tap water on the internal side of the lid every day. All Petri
dishes are kept in a large glass container under controlled conditions in terms of air humidity,
temperature and light regimen (16:8h light:dark photoperiod) (Figure 5).
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Figure 5: A laboratory culture of P. scaber in glass container filled with soil and dry leaves: (A) Petri dish with
leave treated with nanoparticles as animal only food source (B) and glass container with Petri dishes with leaves
and animals, which is kept under controlled conditions (C).

After the animals are exposed for 14 days to treated leaves, the fecal pellets and leaves are removed
from the Petri dishes, dried at room temperature for 24 h, and weighed separately. The feeding rate of
isopods is calculated as the mass of consumed leaves per animal wet weight per day. The food
assimilation efﬁciency is calculated as the difference between the mass of consumed leaves and the
mass of fecal pellets divided by the mass of consumed leaves. The amount of NPs consumed can be
also calculated on the basis of the quantity of leaf consumed and the amount of particles applied on
the leaf, with the assumption that the suspension is applied evenly on the leaf surface. The weight
change of an animal is calculated as the difference in its mass from the beginning to the end of the
experiment.

After the feeding exposure the animals are sacrificed and the tissues are analysed. After 14 days of
feeding the total amount of uptake of NPs (metal) in the tissue is measured with atomic absorbtion
spectroscopy (AAS) method (Golobič et al, 2012, Annex 2), biodistribution of metals is observed with
proton induced x-ray emission (PIXE) (Novak et al, 2012) or Laser Ablation Inductively Coupled
Plasma Mass Spectrometry (LA-ICPMS). Assays have also been developed for studying cell
membrane integrity and biochemical and molecular changes after NPs digestion (Valant et al., 2009;
Romih et al., 2015).
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3.1 Validation of the feeding assay with isopod Porcellio scaber
3.1.1 Presentation of the assay
University of Ljubljana was a project partner in NanoValid, a project where the reference methods for
toxicological testing, NPs exposure and effect assessment have been developed. Within the project the
protocol for exposure and effect of nanomaterials on terrestrial invertebrate organism Porcellio scaber
was validated. Data on the intra- and inter- laboratory comparisons have provided evidence, that the
assay exhibits good repeatability and has the potential to be further validated to reference method for
nanomaterial induced terrestrial invertebrate toxicity and bioaccumulation.
In the laboratory comparison studies, NanoValid CuNPs were used as testing nanoparticles. In
addition, also copper salt was tested. All partners tested the following concentrations: 2000 µg Cu
(CuO NPs) /g leaf, 5000 µg Cu (CuO NPs) /g leaf, and 5000 µg Cu2+/g leaf. Results showed that the
measured concentrations of Cu on leaves that have been sent by the participants were close to nominal
values as reported also by the reference laboratory, UNI-LJ. Greater variability of Cu content was
observed in case of 5000 µg CuO NPs/g leaf in comparison to lower concentration (Figure 6).

UNILJ

partner 1

partner 2

partner 3

Concentration of Cu on the leaf
[µg/g dry mass]

8000
7000
6000
5000
4000
3000
2000
1000
0
-1000
REF.
C
CONTROL

2000 5000 5000
CuO
Cu2+

C

2000 5000 5000
CuO
Cu2+

C

2000 5000 5000
CuO
Cu2+

C

2000

5000 5000
CuO
Cu2+

Figure 6: Copper concentration on the leaves (µg Cu/g leaf) in the reference laboratory (UNILJ), and three
participants. Symbols on the box plot represent value: maximum and minimum value (whiskers: ┴), mean value
(■), outliers (-).
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The median values for feeding rate from all participants were in the interval of reference feeding value
for control population [0.032, 0.073] mg/g (Drobne and Drobne, 2014). The participants obtained the
same 2 weeks LOEC 1feeding rate as in our laboratory (5000 µg Cu/g leaf exposure) (Figure 7).
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Figure 7: Feeding rate of animals exposed to 2000 and 5000 µg Cu/g leaf. Nominal exposure concentrations of
Cu are provided on x-axis. Symbols on the box plot represent: maximum and minimum value (whiskers: ┴),
mean value (■), outliers (-), and p<0.05 (*; Mann-Whitney). Red dotted lines are reference feeding value for
control population (Drobne and Drobne, 2014).

In conclusion, the validation study with the isopods within the NanoValid project revealed that the “In
vivo feeding exposure of isopods (Porcellio scaber, Isopoda, Crustacea) to nanomaterials” is
repeatable and reproducible and can thus serve as a basis for the development of other test assays with
this test model.

1

LOEC: Lowest Observed Effect Concentration
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3.1.2 Implementation of validated feeding assay with isopod Porcellio scaber – exposure to NPs
produced in NanoMILE project

In the NanoMILE project, a range of nanoparticles were produced, and a selection of these were used
in WP6 in order to establish in vivo reactions between NPs and selected organisms. We used the
established validated SOP for feeding experiments to expose model organisms to the NPs. We
implemented the validated data with the results on how these tested NPs affect the feeding behavior of
isopods. One of the objectives of WP6 was to establish if specific features, like ageing of NPs confer
significant alteration in biological system. In addition the aged NPs were tested to assess what could
possibly result in different feeding activity of animals.
In one experiment, animals were exposed to Ag NPs and to same, but aged NPs, with exposure
concentration 1000 µg Ag/g leaf. In a separate experiment, animals were exposed to aged (done by
NanoMILE partner, University of Birmingham) and non-aged CeO2 NPs with exposure concentration
1000 µg Ce/g leaf. The results showed that there was no statistically significant effect of tested
materials on feeding behavior of isopods (Figure 8). We compare the obtained values with reference
control values for feeding rate and conclude that obtained data were in the interval of reference
feeding value for control population (0.032, 0.073) mg/g (Drobne and Drobne, 2014) as in the
validation study of project NanoValid.

Figure 8: Feeding rate of animals exposed to 1000 µg Ag and CeO2 (non-aged and aged)/g leaf. The AgNO3 and
Cu2+ are positive controls. Nominal exposure concentrations (1000 µg NPs/g of food) and number of animals
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per group are provided on x-axis. Symbols on the box plot represent: maximum and minimum value (whiskers:
┴), mean value (□), outliers (-). Red dotted lines are reference feeding value for control population (Drobne and
Drobne, 2014).

3.2 Validation of the NPs (or metals dissolved from them) bioaccumulation assay with isopods
The second commonly applied assay with isopods is the study of bioaccumulation of NPs. The study
relies on the 14 days of feeding on NPs, and then the isopods are sectioned, digestive glands are
isolated and the concentration of metals is measured with one of the techniques to study the body
burden of NPs in organisms, by AAS or ICPMS. The assay on the bioaccumulation of metals
dissolved from CuO NPs has also been validated within the NanoValid project. The data of copper
analysis of animals were comparable to the reference laboratory and revealed that the Cu-exposed
isopods accumulated significantly more Cu than control animals (Figure 9).
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Figure 9: Bioaccumulation of copper in the whole body of isopods. Symbols on the box plot represent:
maximum and minimum value (whiskers: ┴), mean value (■), outliers (-), and p<0.05 (*; Mann-Whitney).

The protocol will be implemented with the results on bioaccumulation of NPs produced in the
NanoMILE project and data will be represented in other deliverables (work in the Task 6.1 and 6.3) of
WP6.
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4 Maternal transfer studies in the NanoMILE project

The knowledge gained within the validation of the “Feeding and bioaccumulation assay with isopods”
tested with NanoMILE NPs was used to develop a new model assay for the NPs maternal transfer
studies. Here we present the development of this assay.

The females of isopods with marsupium from laboratory cultures were exposed to selected NPs. Their
feeding behavior was observed, the number of juveniles hatched after female exposure to food treated
with metal NPs was counted and the bioaccumulation of the metals in the juveniles and the females
was measured (feeding method based on: Annex 1: SOP In vivo feeding exposure of isopods
(Porcellio scaber, Isopoda, Crustacea) to nanomaterials, established in the NanoValid project). We
conducted four experiments:

Nanoparticles

Exposure

Number of

Duration of

concentration

exposed

experiment

females/group
Experiment 1

TiO2 and TiO2 with

1000 µg of TiO2

PVP (NNM PROm-

NP/g of food

10

2 – 28 days

10

1-19 days

5

7-14 days

5

3 days

TiO2un-10nm-121113c
and NNM PROmTiO2PVP-10nm121113c)
Experiment 2

Experiment 3

Experiment 4

Ag NPs (Silver(JRC)-

1000 µg of Ag

NM300K)

NP/g of food

Ag NPs (Silver(JRC)-

1000 µg of Ag

NM300K)

NP/g of food

Ag NPs (Silver(JRC)-

1000 µg of Ag

NM300K)

NP/g of food

Table 1: Feeding exposure of females with developing marsupium experiments conducted with NanoMILE
nanoparticles.
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The time of exposure in standard feeding assay is 14 days. In the four maternal feeding experiments
conducted, the time of exposure varied because of different stages of intramarsupial development of
juveniles. We observed the developing embryos through the brood pouch with stereomicroscope.
In the first experiment we collected females which appeared to have a late stage marsupium, but some
of the juveniles underwent hatching from marsupium after only two days of feeding females on NPs.
The longest period of exposure to hatching was 28 days. In the second experiment we tried to choose
population of females in more uniform stage of intramarsupial development but again the hatching of
some juveniles had already started after one day of exposure; some of the animals in the experiment
did not hatched before 19 day of exposure. In a third experiment the juveniles hatched between 7 and
14 days.

When the animals are hatched from the marsupium (which can happen at night time) they can
immediately consume the leaves treated with NPs (the only food source in the Petri dish), and this in
turn could be the source of measured metals in their bodies. We concluded that we could not establish
the intramarsupial development states of juveniles in the marsupium without isolating them. With
isolation of even one or two juveniles the marsupium would be disrupted and maternal transfer could
be interrupted. Based on this observations we decided to adopt the feeding protocol and expose
females with marsupium only for 3 days ( Experiment 4) and then isolate the juveniles directly from
the marsupium and prepare them for bioaccumulation studies. In that experiment animals were
exposed to silver NPs and positive control (CoCl2 with concentration 2000 µg of Co/g of food). We
were unable to do more experiments at the time because of the lack of fertilized females in the
laboratory culture.

In the experiments survival of females and their feeding behavior (feeding rate) was observed. In the
experiment 3, when hatching from the marsupium occurred, juveniles were counted.

4.1 Results on feeding behavior, survival of females and number of hatched juveniles

The survival of females in the experiment 1 and 2 was low in controls where 50% of control animals
die in the experiment 1 and 30% of animals did not survive in the experiment 2. In the Experiment 3
and 4 survivals of animals in control and in all exposure groups was 100%. In the group exposed to Ag
NPs in experiment 4 the survival rate was 80% (Figure 10).
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Figure 10: Percentage of females surviving in each experiment. In experiment 1 and 2, 10 animals per group
were exposed and in experiment 3 and 4, 5 animals were exposed to food dosed with nanoparticles. The nominal
exposure concentrations were 1000 µg of TiO2 NP or Ag/g of food and for positive control 2000 µg of Co/g of
food.

The first two experiments were performed with animals from the same laboratory culture and after the
experiments we observed high percentage of animals with digestive glands bacterial infection (Figure
11) in the culture and this invalidated the results from these experiments. Only experiments 3 and 4 are
considered as valid.

Figure 11: Cross section (A) and longitudinal section (B) of digestive gland of control animal. Hematoxylin and
eosin staining. Hypertrophed cells seen as violet dark regions stained by hematoxylin (stains nucleic acids),
filled with intracellular bacteria in different developmental stages.
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Feeding rate (calculated per day of exposure) in two valid experiments (exp. 3 and 4) was comparable
to feeding value for control population median values (0.032mg/g, 0.073mg/g respectively) of animals
fed with Cu NPs, established in the work of Drobne and Drobne (2014). There was no statistical
differences among control and exposure groups in the case of exposure to NPs (experiment 3 and 4) or
only Ag dispersant (Experiment 3). A statistically significant smaller feeding rate was observed with
positive control (CoCl2) in both experiments (Figure 12).

Figure 12: Feeding rate of animals exposed to 1000 Ag/g leaf (for Ag NPs and Ag dispersant) and 2000 and µg
Co/g leaf for the positive control. Number of survived animals are represented x-axis (n). Symbols on the box
plot represent: maximum and minimum value (whiskers: ┴), mean value (□), outliers (-) and p<0.05, p<0.01
(*;**, Mann-Whitney).

In the literature it has been reported that exposure of females to metal pollutants in the environment
can affect the number of young per female (Surbida and Wright, 2001). In experiment 3 we have not
observed changes in the number of juveniles after NPs ingestion (Figure 13). In experiment 4 the
juveniles were removed directly from marsupium and some of them were in the too early development
state to be counted, therefore the data for number of juveniles in this experiment are missing.
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Figure 13: Number of survived juveniles per female exposed to 1000 µg of Ag or Ag dispersant/g leaf and
2000 and µg Co/g leaf for the positive control. Number of survived animals are represented x-axis (n). Symbols
on the box plot represent: maximum and minimum value (whiskers: ┴), mean value (□), outliers (-).

We also concluded that the duration of exposure or the female initial weight is not correlated with the
number of juveniles hatched in experiment 3 (Figure 14).
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Figure 14: Number of surviving juveniles per female (A) in experiment 3, where each column represent one
animal. On each column the number of days (d) of exposure for each female is written. On the lower figure the
weight of each female before the experiment is represented (B). Exposure concentrations were 1000 and µg Ag/g
leaf and 2000 and µg Co/g leaf for the positive control.

4.2 Bioaccumulation of silver in exposed females and juveniles

We measured the accumulation of metals in animals only after Experiment 4, where females were all
exposed for same time period and juveniles were removed directly from the marsupium before they
19

were hatched. After the experiment females and juveniles were shock-frozen in liquid N2, using
tissue-freezing medium, cryo-sectioned and lyophilised. We combined samples of juveniles from all 5
females from one group in one sample in order to have enough sample volume for the detection of
contained silver (level of detection, LOD, is 15 µg/L). Prior to analysis, dry samples were digested in a
heating block with a mixture of concentrated nitric (65% HNO3), and perchloric acid (70% HClO4)
(HNO3:HClO4 = 7:1, v/v). After evaporation of the acid, the residue was dissolved in 0.2% HNO3. The
total Ag concentrations in the samples were analyzed with a flame atomic absorption spectrometer
(Perkin Elmer AAnalyst 100). Within each measurement, a certified reference material (TORT-2,
National Research Council of Canada) was used to check the accuracy and precision of the analytical
procedures. Results showed that silver is accumulating in the females exposed to Ag NPs dosed food,
but not in the juveniles (Figure 15).

Figure 15: Bioaccumulation of silver in the whole body of females (measurements for 5 females per group) and
in juveniles (one sample of combined juveniles from 5 females). Symbols on the box plot represent: maximum
and minimum value (whiskers: ┴), mean value (□), outliers (-), and p<0.01 (**; Mann-Whitney). Exposure
concentrations were 1000 and µg Ag/g leaf .
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5 Discussion and Conclusions

The comparison of results of the feeding assay with isopods obtained within NanoValid project with the
new data obtained with NanoMILE NPs, provided evidence, that the assay exhibits good repeatability.
The tested NPs (aged and non-aged) did not affect the feeding behavior of model organisms. Control
values were in the range of reference feeding values for control population.
Within the NanoMILE project we have tested a new model isopod system for maternal transfer
studies. We exposed females with developing marsupium to TiO2 and Ag NPs produced in the project.
We were observing changes in feeding behavior of exposed females, their survival and finally the
changes in number of hatched juveniles upon NPs digestion by females. We measured the
bioaccumulation of metals originating from NPs in the females and in juveniles in order to establish
the maternal transfer of ingested elements into developing eggs in marsupium. We did not observe
any effect of NPs on this maternal transfer, however the bioaccumulation of silver in the Ag NPs
exposed females was observed.
The problems which can occur observing widely used toxicological endpoints like survival, growth, and
reproduction, is in their low sensitivity. Biochemical, histological, and physiological endpoints are often
more sensitive and suitable. It is known that isopods can survive large doses of pollutants, in particular
metals, so the survival is not necessarily a suitable endpoint for measuring effect of NPs exposure. In
our two valid experiments, the feeding rate of isopods exposed to Ag NPs was not affected.
Statistically significant decrease of feeding rate was observed only in the case of positive controls.
However, the ingestion of NPs is proven to be able to affect the feeding behavior of isopods (Jemec et al.,
2008; Novak et al., 2012; Pipan Tkalec et al., 2011) and therefore is considered to be an informative
endpoint in the feeding assay.
Another disadvantage of this model is in generally less frequent and less regular breeding in isopods
maintained in the laboratory (Steel, 1980) as in their natural environment. Although we are
maintaining several laboratory cultures, the reproduction is altered and is not as regular and frequent.
For that reason, the experiments for maternal studies are limited with number of females carrying
marsupia available for conducting the experiments. The females carrying eggs are also more
susceptible to stress and possibly to bacterial infections. We observed high percentage of infection of
our laboratory cultures after the period when the first two experiments were conducted; therefore we
assumed that infected animals were included in the experiments. We confirmed that by isolating and
observing histopathology of digestive glands of survived females in the experiments. Terrestrial
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isopods are often invaded by intracellular bacteria with a complex developmental cycle. The outcome
of that infection is pathological change in infected hepatopancreatic tissue and in the last stage of the
bacterial life cycle, cell death occurs. During the infection, physiological state of animals is changed
and because of that we cannot consider the results obtained with infected population as reliable. We
propose that laboratory cultures of isopods are regularly checked for intracellular infection and that
infected animals are not used in the experiments.

Another endpoint observed after feeding assay with females carrying marsupium was bioaccumulation
of metals originating from ingested NPs in the females and possibility for maternal transfer of NPs on
juveniles during the intramarsupial development. We did not succeed to visually establish the state of
intramarsupial development of juveniles using light microscopy and because of that juveniles were
hatched from marsupiums in different time periods, a fact which disabled a 14 day experiment as per
the validated feeding protocol. Immediately after hatching juveniles can eat the food dosed with NPs
or even maternal feces, so it is important that they are removed from the marsupium after the exposure
of females. Therefore we adjusted the time period of exposure for 3 days and after that juveniles were
isolated and removed directly from the aqueous brood pouch. The results of the experiment where
females were exposed to Ag NPs showed that also in that short period (3 days) silver was
accumulating in the females but not in the juveniles. In future experiments, we will optimize the
protocol in a way that we will collect the females with early stage of marsupium from laboratory
cultures and exposed them to NPs at least for seven days to confirm the result, that maternal transfer of
NPs or ions dissolved from NPs is not taking place. As the part of our work in the other tasks in which
we are participating (Task 6.4 in the WP6) the maternal transfer protocol will be intra-laboratory
tested with NanoMILE NPs and the results will be presented.
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ANNEX 1

NANOVALID–TEST METHOD DESCRIPTION FORM

INFORMATION ON TEST METHOD AND PROPOSER / PARTNER
Name of test method

Acronym of test method
Status of the SOP
Proposer - Organisation
Postal address

In vivo feeding exposure of isopods (Porcellio scaber, Isopoda,
Crustacea) to nanomaterials

IsopodFeeding
Internal

Draft

University of Ljubljana

Prevalidated



Validated

Biotechnical

Department

faculty

Biology

of

Večna pot 111, 1000 Ljubljana, Slovenia

Name of contact person

Prof. Dr. Damjana Drobne, Doc. dr. Anita Jemec

Tel. no. of contact person

+ 386(1) 320 33 75

Fax no. of contact person

+ 386(1) 257 33 90

e-mail of contact person

Damjana.drobne@bf.uni-lj.si; anita.jemec@bf.uni-lj.si
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1.Describe the scientific and technical basis of the test method
Terrestrial isopods are a good choice for toxicity studies since their digestive system is the main route for
contaminant intake and their accumulation in the body is attributed solely to dietary exposure (Drobne
1997). Isopods have been shown to accumulate the highest concentrations of metals such as zinc,
cadmium, lead, and copper so far recorded in any soft tissue (Hames & Hopkin 1989). Metals are
accumulated in digestive gland (hepatopancreas). This phenomenon has been used in variety of
ecophysiological, ecotoxicological (reviewed in Drobne 1997) and recently nanotoxicological studies
(Pipan-Tkalec et al. 2010, 2011; Golobič et al. 2012; Novak et al. 2013a, 2013b) where bioavailability of
metals in the digestive system was of interest.

Exposure of terrestrial isopods (prominently P. scaber) to contaminant-treated food was established as a
standard toxicity testing protocol by Drobne and Hopkin (1994, 1995) and was later on adapted for
nanotoxicity testing (Golobič et al. (2012). Feeding exposure is the most important means for in vivo
exposure of P. scaber to nanoparticles; moreover, it enables assessment of the exact exposure dose
(Drobne 1997), which is harder to estimate with other terrestrial invertebrates (e.g. earthworms,
collembolans). This protocol serves as a basis for other analyses (e.g. AAS measurements of tissue metal
content, AO-EB test for cell membrane integrity, lipid peroxidation assay of digestive gland cells etc.).

In the scope of this feeding assay, feeding rate, fecal production rate and food assimilation are evaluated.
This enables assessment of organism-level physiological response to nanoparticles and their potential
toxicity (in case of elevated mortality of test animals).

2. Describe the role of the method in context of …
This protocol describes how to set up a feeding experiment (in vivo exposure) with terrestrial
isopod Porcelio scaber (Isopoda, Crustacea) as a pre-requisite for other analyses based on in
vivo exposure. This protocol needs to accompany all the other SOPs for the analyses based on
P. scaber tissues.
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3. Describe the Standard Operating Procedure (SOP)
A.

Reagents and Materials

Materials/Reagents/Equipment

Vendor

Stock Number
(content, if self-prepared)

Reagents
deionized water

own production (by a waterpurification system, e.g.
Millipore)

as much as necessary

nanoparticles

NanoValid consortium

depends on the aim of the
experiment; usually in a mg/mL
concentration

P. scaber saline solution

Sigma-Aldrich, Merck or similar; per 0.5 L: 7.265 g NaCl, 0.2984 g
all the chemical must be of a
KCl, 0.476 g MgCl2, 0.45 g
reagent grade
glucose, 0.6 g TRIS

Add dH2O, adjust pH to 7.4
Consumables
paintbrushes

local vendor

separate brush for each
chemical

plastic Petri dishes with vents

e.g. Greiner

separate dish for each test
animal

laboratory gloves

e.g. Shield

pipette tips

e.g. Brand

Equipment
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vortex shaker/mixer

e.g. Scientific Industries, Inc.

laboratory scale/balance

e.g. Sartorius

pipettes

e.g. Brand, 20-200 µL

stereomicroscope

e.g. Leica, Zeiss

stainless steel tweezers

SPI Supplies, West Chester, PA,
USA local vendor

scissors

B.
Safety procedures and precautions
Bioassays are performed taking into consideration the following safety precautions: inhalation of
ENM powder and exposure of the skin to ENMs are hazardous. Nanomaterials are weighed in a
ventilation hood and liquid phase (dH2O, buffers) is added right after. Sonication of nanoparticles
is performed in a closed containment. Handling of all nanomaterials (and their suspensions) is
always performed with laboratory gloves and a lab coat. Applying suspensions of nanomaterials on
the leaves is performed in a laboratory.
C.
Procedure
C.1. Reagent/Stock preparation
C.1.1 Preparation of nanoparticles stock suspensions
Suspensions of nanoparticles for feeding experiments are always prepared in deionized water (dH2O).
Stirring of aqueous dispersion and sonication is applied when required. Depending on the amount of
nanoparticles that needs to be applied on the leaf surface, stock suspension is prepared (e.g. if the desired
dosage of nanoparticles was 1000 µg/gram dry weight of leaf, a suspension of 1000 µg/mL should be
prepared, 1 mL of which is then applied on the surface of 1 g of leaves).

C.1.2 P. scaber saline solution
Prepare the P. scaber saline solution by weighing 7.265 g NaCl, 0.2984 g KCl, 0.476 g MgCl2, 0.45
g glucose and 0.6 g TRIS to 500 mL of dH2O. Adjust pH to 7.4
C.3. Procedure

C.3.1 Feeding experiment: experimental set-up
C.3.1.1. Petri dish labeling
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Write the following on the dish cover:
1. experiment Nr.,
2. experiment holder name,
3. particles used and their concentration,
4. Petri dish / test animal Nr.,
5. mass of the leaf,
6. mass of the animal.

Write the following on the bottom of the dish:
1. experiment Nr.,
2. Petri dish Nr.

C.3.1.2 Applying chemicals/suspensions of nanomaterials onto leaves

1. The nanoparticles suspensions should be vortexed before application.
2. Pipettes should be calibrated before use.
3. Cut pieces of dried leaves to 100 ±10 mg.
4. Weigh the pieces of leaves and write down the mass on the Petri dish.
5. For spreading the chemicals/nanomaterials on the leaves, a brush is used.
6. Before the application starts, the brush must be dipped in deionized water.
7. Chemicals/ suspensions of nanomaterials are applied to the abaxial side of the leaves in the volume
corresponding to the leaf weight, with a reference volume of 100 µL of the liquid phase per 100 mg of
dried leaves.
8. Chemical/suspension of nanomaterials should be spread as evenly as possible, covering the whole
surface of the leaf.
9. Avoid prominent leaf veins.
10. After the chemicals/suspensions of nanomaterials are applied, the leaves should be left in Petri dishes
for 24 hours at room temperature to dry.
11. After 24 hour period the leaves are weighed. The value obtained is used for further calculations.
C.3.1. 3 Starting the feeding experiments

1. Weigh each animal.
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2. Only adult animals exceeding 30 mg are used in the experiments. If moulting or the presence of
marsupia is noted, animals are not used in feeding experiments.
3. A single animal along with a treated leaf is placed in a Petri dish.
4. At least 10 animals per concentration should be used.
5. Cover of a Petri dish is sprayed with deionized water from the inside. The sprayed water should be
applied in tiny droplets only.
6. Petri dishes are transferred into a glass or plastic made terrarium. The bottom of the terrarium must
be covered with a few layers of moist paper towels. The terrarium is then covered with a plastic foil
which prevents the water evaporation. A few holes should be punctured in the foil which will allow the
air flow.
7. The terrarium is placed in a cultivation chamber which ensures controlled and stable condition with the
temperature of 20 +/- 2 ºC and natural light cycles of 16 hours of light, followed by 8 hours of darkness.
8. Duration of exposure depends on further analysis and is usually 14 days.

C.3.1.4 Maintenance of animals during the feeding experiment

Petri dish should be kept moist for the whole period of the experiment. Care should be taken to sustain
enough but not too much moist inside the terrarium. If the leaves appear to be wet and there are water
drops forming on the bottom of the Petri dish, there is too much moist inside the terrarium.

Animals should be checked every day or at least every second day. Dead animals or females with marsupia
should be removed from the experiment.

Once a week, fecal pellets should be picked up from the Petri dish of every animal in a following way:

1. Take new Petri dishes and mark them accordingly. Moist the covers with distilled water and transfer
the animals from the original Petri dishes of the experimental group. Add nothing else. Keep them
away from heat and direct sun.
2. Leave the original Petri dishes open so that they dry out before removing the fecal pellets.
3. Take Eppendorf tubes, mark and weigh them.
4. Pick up all the fecal pellets from each Petri dish using a brush. Transfer them to Eppendorf tubes in the
way that the numbers match.
5. When done, put the animals back to the original Petri dishes and moist them.
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C.3.2. Transferring the animals to untreated food (for measurements where NP content in the gut may be
an interference, e.g., AAS measurements, see “Microwave acid digestion of organic material”)

1. Take new Petri dishes and mark them
2. Put a piece (20–100 mg) of untreated leaf in each dish and moist the covers.
3. Transfer the animals from the original Petri dishes to the new ones.
4. Keep them under controlled conditions (20 +/- 2 ºC and natural light cycles of 16 hours of light,
followed by 8 hours of darkness) in a cultivation chamber for 24 hours.

C.3.3. Finishing the feeding experiment
1. Weigh each animal.
2. Leave Petri dishes with fecal pellets and remnants of the leaves for at least 24 hours to dry at room
temperature.
3. After at least 24 hours, collect the fecal pellets, put them in Eppendorf tubes and weigh them. Weigh
the dry leaves.
4. Mark everything and store away so that it can be found for possible future analysis.
5. If AAS measurements of separate animal parts will be performed or membrane integrity of digestive
glands will be assessed (using AO/EB differential staining), the animals need to be dissected (see point
C.3.4).
C.3.4. Dissection
1. Before the dissection, prepare a stereomicroscope, scissors, tweezers, some distilled water, some
alcohol, and a small Petri dish with P. scaber saline solution.
2. Examine the animal under the stereomicroscope and write down any findings.
3. Cut off the head and isolate digestive glands. Describe the glands thoroughly and write down all the
findings. Cut off the rear of the animal and remove the gut. Describe the digestive organs thoroughly
and write down all the findings (please see Fig.1. in annex for structure of isopod digestive system).
4. Depending on desired analyses, store the tissue accordingly.

C.4. Data analysis
Write down the following data:
1. mass of leaves before and after feeding experiment,
2. mass of test animals before and after feeding experiment,
3. mass of fecal pellets after the experiment,
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4. gender and anomalies (death, moulting of animals) – data from dead and moulting animals are not
included in the calculation of feeding rate, fecal production rate and food assimilation efficiency.
Calculate*:
1. feeding rate,
2. fecal production rate,
3. food assimilation efficiency.

*equations are provided in Annex

4. Performance assessment of the method
•

Describe the scope of the performance assessment study and how it was undertaken.

Validation of the SOP was done in the scope of D 5.54 deliverable: Reports on development of standard
protocols for reference methods: Reports on development of standard protocols for reference methods
for (1) toxicological testing, (2) ENP exposure assessment, (3) assessment of the ENP impact on human
and environmental health.
•

What test substances were used for assessment purposes and what was the basis for their
selection?

The reference chemical (positive control) was Cu(NO3)2·3H2O The chemical was selected on the basis of
isopod physiology.
•

What were the specific criteria used to judge/describe test method performance?

We consider the test valid when the following criteria have been met:
1. The mortality of control isopods within the exposure period is ≤ 20 %,
2. Therefore, we consider the reference values for our laboratory control P. scaber between 0.03
and 0.07 mg/g of feeding rate per day ([0.03<FR<0.07] mg/g) when their weight at the beginning
of the test was in the range between 34 and 54 mg ([34<IW<54] mg) (Drobne and Drobne, 2014)
The test animals shall be adults, exceeding 30 mg. If moulting or the presence of marsupia is noted,
animals are not used in further feeding experiments and data analysis.
•

Was the study conducted under GLP, and/or did it adhere to a recognised quality system?
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The study was not conducted according to a recognised quality system.

What was the reliability of the assay in terms of intra-lab and inter-lab reproducibility?

•

ADDITIONAL INFORMATION – Expand on to further pages if required
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8. Add here any further information or particular attributes of this Assay/Test and associated
datasets that will assist project partners, or a potential third party making use of NANOVALID
data, to correctly interpret and analyse the data
(Continue on additional pages if required, or add as addition attachments).
Description and calculation of feeding parameters of P. scaber
In isopods, high levels of metals in food are known to depress food consumption; moreover, metal
poisoning may be evaded by an avoidance response, by regulation of the consumption rate, by storing
metals in hepatopancreas in insoluble form, and/or by fecal and possibly also urinary excretion (reviewed
in Drobne and Hopkin 1995).

Generally, decreased feeding rate, decreased fecal production rate and increased food assimilation
efficiency denote an adverse effect of a test chemical to the isopods.

Calculation of feeding parameters (for an individual animal) is as follows:

Feeding rate=

mass of consumed leaves during the experiment (mg)
average mass of the animal during the experiment (mg)

Fecal production rate=

mass of fecal pellets during the experiment (mg)
average mass of the animal during the experiment (mg)

Food assimilation efficiency=
mass of cosumed leaves (mg)-mass of fecal pellets (mg) during the experiment
mass of consumed leaves during the experiment (mg)
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Fig.1. Scheme of a terrestrial isopod Porcellio scaber: (A and B) digestive system anatomy, (C)
scanning electron micrograph of isolated digestive gland tube (Valant et al., 2012).*

stomach

gut

Hepatopancreatic tube

*Valant J, Drobne D and Novak S. 2012. Effect of ingested titanium dioxide nanoparticles on the
digestive gland cell membrane of terrestrial isopods. Chemosphere Vol 87, Issue 1,Pages 19–25
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ANNEX 2

NANOVALID –TEST METHOD DESCRIPTION FORM

INFORMATION ON TEST METHOD AND PROPOSER / PARTNER
Name of test method
Acronym of test method
Status of the SOP
Proposer - Organisation
Postal address

Measurements with flame AAS

FAAS-measure
Internal

Prevalidated

Draft

University of Ljubljana

Validated

Biotechnical

Department

faculty

Biology

of

Večna pot 111, 1000 Ljubljana, Slovenia

Name of contact person

Prof. Dr. Damjana Drobne, Doc. dr. Anita Jemec

Tel. no. of contact person

+ 386(1) 320 33 75

Fax no. of contact person

+ 386(1) 257 33 90

e-mail of contact person

Damjana.drobne@bf.uni-lj.si; anita.jemec@bf.uni-lj.si
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1. Describe the scientific and technical basis of the test method
Atomic absorption spectrometry (AAS) is an analytical technique for qualitative and quantitative
determination of chemical elements. AAS enables determination of more than 70 elements (mostly
metals and metalloids) in very low concentrations (in the ppm range, i.e. mg/kg or mg/L). The accuracy is
very good; the extent of measurement error is about 1-2%. Flame AAS (FAAS) is one of four commonly
used AAS techniques, others being graphite furnace AAS (GF-AAS), inductively coupled plasma optical
emission spectroscopy (ICP-OES) and inductively coupled plasma mass spectrometry (ICP-MS).

FAAS is based on the fact that metal atoms in the ground state absorb light of specific wavelengths.
Analyte of interest needs first to be atomized in a flame. A beam of light of a suitable wavelength (in the
ultraviolet or visible region of the spectrum) passes through the nebulized sample and converts atoms of
the analyte to the excited state. Characteristic excitation wavelengths are specific to each element and
precise to 0.01-0.1 nm. Concentration of the element in the sample is determined from the absorption
rate, which is compared to the working curve obtained after calibrating the instrument with standards of
a known concentration. FAAS is a monoelemental technique.

This protocol describes calibration and measurements with flame atomic absorption spectroscopy (flame
AAS) and it is written on the basis of Perkin Elmer AAnalyst 100 spectrometer.

2. Describe the role of the method in context of …
In nanotoxicity studies, this method is applied to determine the amount of metals in aqueous dispersions
of nanomaterials and in organic material, for instance Porcellio scaber tissues and dry tree leaves (food
for feeding experiments with isopods).

This SOP needs to be accompanied by SOP for feeding experiments with isopods and SOP for microwave
acid digestion of organic material (Porcellio scaber tissues and dry tree leaves).
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3. Describe the Standard Operating Procedure (SOP)
A.

Reagents and Materials

Materials/Reagents/Equipment

Vendor

Stock Number (content, if self
prepared)

Reagents
deionized water

standards for AAS (containing

own production (by a waterpurification system, e.g.
Millipore)

e.g. Perkin Elmer, Merck,
Sigma Aldrich

1 mg/ml of analyte of interest)

as much as necessary

calibration standards prepare
by dilution according to the
theoretical recommendations
for standard concentration

e.g. Merck, Sigma Aldrich

prepare stock of 0.2% HNO3 in
deionized water

65% HNO3, reagent grade
Consumables
glassware (beakers, Erlenmeyer flasks,
volumetric flasks)

glass test tubes

plastic stoppers for test tubes

plastic Pasteur pipettes

e.g. Brand

e.g. Brand

e.g. Brand

e.g. Brand
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micropipette tips

e.g. Brand

laboratory gloves, latex and nitrile

e.g. Shield

Parafilm M

Pechiney Plastic Packaging

Equipment
flame atomic absorption
spectrophotometer

acetylene supply

oxidant (air) supply

Perkin Elmer AAnalyst 100

Messer

own production by an air
compressor

adjustable micropipettes

e.g. Brand

vortex shaker/mixer

e.g. Scientific Industries, Inc.

B.

acetylene pressure in the gas
cylinder must not fall under 8
bar (800 kPa)!

Safety procedures and precautions

All handling of concentrated HNO3 must be performed in a ventilation hood, with a lab-coat,
nitrile gloves and safety glasses. Always wear a lab-coat and latex gloves during AAS
measurements; when directly measuring samples dissolved in concentrated acid, wear nitrile
gloves.
Before each measurement, perform a safety check of the AAS apparatus according to the
manufacturer’s instructions. Always turn on the ventilation during the measurements. When
acetylene supply starts getting low, make sure that acetylene pressure in the gas cylinder does
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not fall under 8 bar (800 kPa), otherwise acetone or dimethylformamide solvent could start
leaking out the cylinder. Perform regular maintenance check of air and acetylene supply
connections to the AAS apparatus (pressure valves, gas hoses) once a year. Provide regular
preventive maintenance by a plenipotentiary service every five years.
Collect drainage liquids from the apparatus, acid and sample leftovers in an inert, appropriately
labeled container. Take all safety precautions for handling toxic waste. Provide safe storage and
deliverance to the specialized institution for destruction.
C.

Procedure

C.1. Reagent/Stock preparation
C.1.1 Preparation of calibration standards
C.1.2.1. General information (standards are appropriate for most samples)
In general, calibration standards for measurement by AAS are prepared from certified solutions
(e.g. PerkinElmer, Sigma Aldrich, Merck etc.) containing the analyte in concentration 1 mg/mL
(1000 mg/L). Certified solution is diluted with deionized water in a volumetric flask to the
desired concentration. Prepare at least 4 concentrations of the calibration standards: the
highest one is at the limit of linearity for the analyte of interest (data on this can be found in
literature) and the other three are relative proportions of the highest concentration.
1. Use calibrated volumetric flasks. Wash them with diluted HNO3, rinse with deionized water
and leave to air dry.
2. Decant a small quantity of the certified solution in an acid-washed beaker, never pipette it
directly from the original bottle!
3. Filled the volumetric flask with deionized water up to a few inches below the etched volume
label, enough for the tips to reach into the liquid.
4. Add an appropriate volume of certified solution into the water in the flask.
5. Carefully add deionized water up to the engraved tag on the volumetric flask by a Pasteur
pipette.
6. Close the volumetric flask with the corresponding stopper and shake well. Store the
standards in a refrigerator until use.
C.1.2.2. Special cases
When samples contain high concentrations of acid/base (mineral or organic), are dissolved
directly in the concentrated acid/base, or contain a high concentration of organic solvents, it is
necessary to prepare specific standards for this purpose. It is known that a high acid content in
the sample may decrease the absorbance of the analyte and a high base content may increase
the absorbance of the analyte if the instrument calibration standards are prepared in deionized
water. The difference in viscosity between the sample and the standard also affects the
absorbance of the analyte. These are collectively known as “matrix effects” and are a cluster of
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basic interferences in atomic spectroscopy.
In order to avoid the matrix effects, the compositions of the sample and the calibration standard
(with the exception of the analyte) need to be as similar as possible. Another option is to use the
method of standard additions. More information on this can be found in textbooks of atomic
spectroscopy, or the user’s manual provided by the manufacturer.
C.2. Preparation of samples
Digest your samples according to SOP for microwave acid digestion of organic material (Porcellio scaber
tissues and dry tree leaves). Dilute acid digested samples with deionized water until the anticipated
analyte concentration falls into the calibration range. Take notes of dilution ratio for further calculations.

C.3. Procedure

C.3.1 Turning on, heating and basic settings of AAS apparatus (PerkinElmer AAnalyst 100)
C.3.1.1. Switching on the apparatus
1. The order of turning on the appliances: AAS apparatus (switch on the bottom right side) →
computer, monitor, printer.
2. Carefully and slowly open the valve on the acetylene cylinder and the valve on the air pipe.
3. Run the program AA WinLab Analyst and wait for a connection between the computer and
AAS apparatus to become established (Checking Connections → check mark turns green).
4. Select: Select Workspace → Use a custom- designed workspace.
Open → Manual.flm → OK
5. In the main window, first check whether the green check mark under the label Safety
Interlocks is on.
If yes, you can begin to work.
If not, there are three options:
- An error has occurred in the gas inlet (you forgot to open the acetylene valve, or the gas
pressure in the hose is too low for any other reason). Check the proper functioning of the
inlet. If everything is in order, check the drainage; otherwise call the maintenance
service.
-

The drainage tank is full. Decant some of the liquid into the waste container.

-

There is a problem with the connection between the drain sensor and the apparatus.
Check the contact. If this does not resolve the problem, call the maintenance service.

C.3.1.1. Warming up lamps
Turn on the appropriate hollow cathode lamp for the analyte of interest and the deuterium
lamp for background correction. The AAS apparatus automatically centers the lamp and sets the
wavelength. The lamp must be left to warm up for at least 15 minutes before the beginning of
measurements.
C.3.1.2. Warming up standard solutions
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Take the flasks with standard solutions from the refrigerator for at least 30 minutes before the
beginning of measurements (even earlier in cold weather or in winter).
C.3.1.3. Preparation of solutions for nebulization between measurements
The apparatus should never be allowed to draw in the air (with the exception of moving the
tube from one fluid to another, where this cannot be avoided)! Before lighting the flame,
prepare a large beaker or Erlenmeyer flask with deionized water and another one with 0.2 %
HNO3. Dip the nebulizer tube in the liquid to draw in between the measurements or for the
purpose of rinsing the nebulizer. 0.2 % HNO3 is used for rinsing the nebulizer between
measurements of samples with high concentrations of metals.
C.3.1.4 . Basic machine settings before measurement
1. Measurement method: File → Open → Method → choose an appropriate method for
measuring the analyte of interest.
2. The results file: button Results set name in the working window → enter the name of the
file, which should contain the essential information, and a longer description.
3. A file with information about the samples: File → Open → Sample info file → select your user
directory from the list and find the stored sample data file.
C.3.1.5 . Establishing sample data files
1. File → New → Method → displays an empty data window.
2. Enter the following information :
-

name of the file,

-

volume units: mL,

-

mass units : mg

-

sample volume: 2 mL or more are recommended

-

names and masses of samples

-

the unit of sample concentration (typically mg/g or mg/L).

3. File → Save → Method → choose your user directory and store the method under the
appropriate name. Note: The program allows only very short names.
C.3.2 Calibrating the AAS apparatus (PerkinElmer AAnalyst 100)
1. Light the flame (Flame control → ON).
2. Click the Blank button to start the procedure. The apparatus automatically sets the lamp
according to the selected method and stores this information.
3. Measure the blank (click the Blank button again) to set the "baseline ".
4. Select: Tools → Continuous Graphics. Draw in the lowest standard and check whether the
measured absorbance is of the optimal value. If it is not, adjust the nebulizer flow until
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appropriate absorbance is achieved.
5. Measure the standards in the ranking order (click the Standard button). The apparatus
automatically calculates the linearity of the curve; if the curve is not linear (the warning
appears), repeat the procedure. Strive to achieve the correlation coefficient (R2) as close to 1
as possible.
6. Perform a quality check using the following procedure:
-

Select : Analyses → Characteristic Conc.

-

Enter the concentration of one of the standards in the top box, and the measured
absorbance in the lower box.

-

Click in the upper box. At the bottom of the window the measured concentration
and the corresponding characteristic concentration values appear.

-

If the values differ by ≤ 10%, continue with measurements. If the values differ by >
10%, repeat the calibration procedure. Check the accuracy of the standards and
prepare new ones if necessary.

7. After completing calibration, measure a blank again.
C.3.3. Performing measurements with the AAS apparatus (PerkinElmer AAnalyst 100)
1. If the samples were prepared by microwave digestion, they can be measured either directly
or after dilution with deionized water until the expected concentration of the analyte
reaches the calibration range. After each sample dilution, homogenize the sample by
vortexing in glass tubes, closed with plastic stoppers.
2. The samples are measured by clicking on the Sample button. The measurement lasts as long
as the green circle on the button is illuminated. On average, each measurement consumes
approximately 1.5 mL sample, which must be considered in their preparation.
3. Measure a blank after every 10 samples. If the content of the analyte in the samples is very
low, the blank needs to be measured more frequently. Between measurements, rinse the
nebulizer by drawing in deionized water and 0.2 % HNO3.
4. If the absorbance of the analyte exceeds the absorbance of the highest standard, dilute the
sample and repeat the measurement.
5. Finish measurements of samples by measuring a blank.
C.3.4. Shutting down the AAS apparatus (PerkinElmer AAnalyst 100)
1. Turn off the flame (Flame control → OFF).
2. Close the valve on the acetylene cylinder and the valve on air pipe.
3. Release the remaining gasses from the system by clicking the Bleed button (always twice!).
4. Close the AA WinLab Analyst program. The printer will automatically print the remaining
data.
5. Turn off the AAS apparatus (switch on the bottom right side) and cover it with plastic foil.
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6. Shut down Windows and turn off the computer. Turn off the monitor and printer.

4. Performance assessment of the method
•

Describe the scope of the performance assessment study and how it was undertaken.

Special performance checks are done at every calibration to ensure the proper functioning of the
apparatus. Perkin Elmer AAnalyst 100 has built-in list of characteristic concentration parameters for each
element. There is a rule that absorbance value at characteristic concentration and measured absorbance
value must not differ for more than 10%. Therefore, before each calibration, the standard solutions are
injected in the “Continuous Graphics” mode to check whether the measured absorbance is of the
optimal value. If it is not, the nebulizer flow is adjusted until appropriate absorbance is achieved. If this
operation still does not yield the optimum conditions, troubleshooting is proceeded.

As a parallel quality check, a multi-element standard (not used for calibration of the machine) is
measured right after the establishment of the calibration curve, in the middle of measurements, and at
the end of the measurements.

•

What test substances were used for assessment purposes and what was the basis for
their selection?

Substances used are genuine Perkin Elmer single-element instrument calibration standards (see
http://www.perkinelmer.com/Catalog/Gallery.aspx?ID=Standards&PID=Atomic%20Absorption%20Consu
mables&refineCat=Consumables%20Category&N=185%20139%2078925%204293911471&PID=Atomic%
20Absorption%20Consumables&TechNVal=4293911471). The basis for their selection is the highest
possible compatibility with the manufacturer’s apparatus.
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What were the specific criteria used to judge/describe test method performance?

•

As stated above, Perkin Elmer AAnalyst 100 has built-in list of characteristic concentration parameters for
each element. The rule – as established by the manufacturer – is that absorbance value at characteristic
concentration and measured absorbance value must not differ for more than 10%.

For measured multi-element standard value of the element of interest, relative standard deviation of 10
replicates must not exceed 3% and the certified value must lie in the 95% CI for mean of means of
measured values.

Was the study conducted under GLP, and/or did it adhere to a recognised quality
system?

•

No, except for the apparatus manufacturer’s (Perkin Elmer) criteria.

What was the reliability of the assay in terms of intra-lab and inter-lab reproducibility?

•

Intra-lab reproducibility is very good. Based on detailed measurement logs we keep, our lab
has always been able to meet abovementioned criteria so far. Moreover, aging of the hollow
cathode lamp (decaying energy) has been observed and the lamp was replaced right due to
expected absorbances not meeting the described criteria.
Inter-lab reproducibility has not been attempted yet.

ADDITIONAL INFORMATION – Expand on to further pages if required
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